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In this project, we will take a quick look at the STM32F103C8T6 Development Board,
which is based on an ARM Cortex-M3 Microcontroller from STMicroelectronics. | will
show you some important features of this board, how to configure your existing
Arduino environment to work with this board and also write the first program, which

is nothing but, yes, you guessed it, a Blinky. So, let's get started.
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Introduction

In the past decade, Arduino has been the go-to board for quick prototyping, hobby
projects or as a beginner's development board to jumpstart their electronics career.
But we all know the limitations of an Arduino board (let us make the discussion about
Arduino UNO as it is the most popular Arduino out there) i.e. it is slow, running only

at 16 MHz, has very limited internal hardware and doesn’t have enough processing
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power or RAM and Flash to run a FreeRTOS based application (technically, you can

run FreeRTOS on Arduino but it is not ideal).

An alternative to Arduino is the STM32F103C8T6 microcontroller-based development
board, which is often called as the Blue Pill (Matrix reference). This microcontroller is

based on ARM Cortex-M3 Architecture manufactured by STMicroelectronics.

STM32F103C8T6 is a very powerful Microcontroller and with its 32-bit CPU, it can
easily beat Arduino UNO in performance. As an added bonus, you can easily program
this board using your Arduino IDE (although with some tweaks and additional

programmer i.e. USB to U(S)ART converter).

[adsense?]

A Brief Note on STM32F103C8T6 Development Board

The following image shows the front and back sides of a typical STM32 Blue Pill
Board. As you can see, the layout of the board is very simple and some might even

confuse it for an Arduino Nano.
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(https://www.electronicshub.org/wp-content/uploads/2020/02/STM32-Blue-Pill-
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An important thing about these boards is that they are very cheap, cheaper than the
cloned version of Arduino UNO. | got this board for approximately $2.5 (180) in my
local electronics store. So, it is obviously a cloned version (probably a counterfeit
STM32 MCU?) and there are many cloned versions of the board available in the

market.

Coming to the Blue Pill board itself, you get the board and two male header strips for

you to solder on to the board (shame that they don't came pre-soldered).

BOOT Selector
(BOOTO - Top STM32F103C8T6
BOOT1 - Bottom) MCU Power LED  SWD Interface
G G 3.3R B11B10B1 BOAZ AS AS A4 A3 a2 AL ADCIDC14C13
microUSB --------.-.a.caoons] GND
Connector J. . NN & . /
\ B o SWCLK
=i SWIO
il’l.l*il’-..t 3.3V

81281351481""-‘18ﬁ3°|10ﬁ Hl2a1583B4 55 B6 B/ B3 B9 oUG 3.3

32.768KHz
Oscillator

8MHz Crystal

Reset Button User LED

(https://www.electronicshub.org/wp-content/uploads/2020/02/STM32F103C8Té6-
Board-Features.jpg)

The other features of the board are as follows:
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It contains the main MCU - the STM32F103C8T6 in a Quad Flat Package.

A Reset Switch - to reset the Microcontroller.

microUSB port - for serial communication and power.

BOOT Selector Jumpers - BOOTO and BOOT1 jumpers for selecting the booting
memory.

Two LEDs - User LED and Power LED.

8 MHz Crystal - Main Clock for MCU.

32.768KHz Oscillator - RTC Clock.

SWD Interface - for programming and debugging using ST-Link.

3.3V regulator (on the bottom) - converts 5V to 3.3V for powering the MCU.

On either long edge of the board, there are pins for connecting various Analog and
Digital (https://www.electronicshub.org/analog-circuits-and-digital-circuits/) I0 and
Power related stuff. The following image shows the pin configuration of the board

along with different functions supported by each pin.
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(https://www.electronicshub.org/wp-content/uploads/2020/02/STM32F103C8T6-Blue-
Pill-Pin-Layout.gif)

As you can from the above image, each pin of the STM32F103C8T6 MCU can have
multiple functions (but only one has to be selected). Also, note that some 10 pins are
5V tolerant, which means that you can connect 5V compatible 10 on those pins

without any worry.

Issues with STM32 Blue Pill Board

If you are planning to buy the cheaper version (which probably most of us will), then
there are some known issues with the boards that you have to be aware of. | have
taken these issues from various forums and faced some problems (USB related)

myself.

e The first main issue is the 3.3V regulator. Though some boards have used
genuine LM1117 3.3V regulators from Tl, most of the cheap development board
are found with small, knock-off regulators from an unknown manufacturer.
These regulators do not have any thermal protection and are easily damaged.
The solution is to use an external regulated power supply, if you have the
option.

e The next two issues are related to the USB. First, the soldering quality of the
microUSB port is very poor and if you frequently remove and insert the cable
into this port, then there is a high chance that the microUSB connector will come
off the board. You can use hot glue to cover the connector.

e The other issue related to USB is the usage of wrong pull-up resistor. According
to the reference manual of the MCU, the USB D+ (named USBDP) must be pulled
high to 3.3V using a 1.5KQ resistor. But as per the schematics of several Blue Pill
boards, all those are using a 10KQ resistor. If you are planning to work on USB
data transfer, then you might not get accurate results. If you are in desperate
need for a solution, then you can solder a 1.8KQ resistor is parallel to the

existing 10KQ resistor. For this, connect the 1.8KQ resistor between pins A12
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and 3.3V pin.
e Other known issues are very hard to press reset button, analog power is

connected to digital power, no Schottky Diode protection for USB, etc.

Highlights of STM32F103C8T6 MCU

Now that we have seen a little bit about the Blue Pill Board, let us now understand
some important features of the heart of the board i.e. the STM32F103C8T6
Microcontroller. As mentioned earlier, this MCU contain an ARM 32-bit Cortex - M3

CPU core with a maximum frequency of 72 MHz.

Let us now see some specifications of this MCU implemented in the Blue pill board.

Memories: contains 64 Kbytes of Flash and 20 Kbytes of SRAM

GPIO Pins - 32 with external interrupt capability
Timers - 3 16-bit Timers, 1 16-bit PWM Timer

PWM Pins - 15

Analog - 10 Channels of 12-bit ADC

12C - 2 12C Peripherals

USART - 3 USART Peripherals with hardware control
SPI - 2 SPI Peripherals

Other Peripherals - USB 2.0 Full Speed, CAN 2.0B

These are some of the highlights and if you want to know more details about the
peripherals, then you have to refer to the data sheet and the reference manual

(highly recommended).

As a bonus topic, let me tell you the naming convention used in STM32 MCUs with the
example of STM32F103C8T6. Each letter in the name of the MCU signifies a special

characteristic.

Character(s) Significance Possible Values
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STM Manufacturer —
(STMicroelectronics)

32 32-bit MCU —-
F Type of MCU F: Mainstream, L: Low power, H: High
Performance, W: Wireless
1 ARM Core Type 0: MO, 1: M3, 2: M3, 3: M4, 4: M4, 7: M7
03 Line of MCU Details about speed, peripherals,
Silicon Process, etc.
C No. of Pins F: 20, G: 28, K: 32, T: 36, S: 44, C: 48, R:
64,66, V: 100, Z: 144, 1: 176
8 Flash Size 4:16, 6: 32, 8: 64, B: 128, C: 256, D: 384,
E: 512, F: 768, G: 1024, H: 1536, I: 2048
KB
T Package P: TSOOP, H: BGA, U: VFQFPN, T: LQFP,
Y: WLCSP
6 Temperature Range 6: -40°C to 85°C, 7:-40°C to 105°C

How to Use the BOOT Pins?

As mentioned earlier, the BOOTO and BOOT1 pins of the MCU are used to select the
memory from which it boots. The following image shows three different options of

boot spaces based on these pins.
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Boot mode selection pins
Boot mode Aliasing
BOOT1 BOOTO
X 0 Main Flash memory Main Flash memory is selected as boot space
0 1 System memory System memory is selected as boot space
1 1 Embedded SRAM Embedded SRAM is selected as boot space

(https://www.electronicshub.org/wp-content/uploads/2020/02/STM32-BOOT-Pins.jpg)

When both BOOTO and BOOT1 pins are LOW, then the internal Flash Memory acts as
the main boot space and when BOOTO is HIGH and BOOT1 is LOW, the System

Memory acts as the main boot space. These two options are important for us.

To upload the code to the Flash Memory of the MCU, you have to select System
Memory as the main boot space. The reason for this is that the System Memory
contains the embedded bootloader, which is programmed during the production

itself by STMicroelectronics.

By booting into the System Memory i.e. the bootloader ROM, you can reprogram the

Flash Memory with your application using USART1 Serial Interface.

Once the program is uploaded to the Flash Memory, you can switch back the BOOTO
to LOW, so that from next reset or power-up onwards, the MCU will boot from the
Flash Memory. If you notice, in both the cases i.e. selecting Flash Memory and
selecting System Memory as boot spaces, the BOOT1 pin is LOW. Only the BOOTO is
toggled between LOW (Flash Memory) and HIGH (System Memory).

BOOTO - HIGH

. 2
A7 RS AS At A3 A2 AL ADCISCLAC

— e —— - i

— e,

BOOT1 - LOW
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Operational Mode

(https://www.electronicshub.org/wp-content/uploads/2020/02/STM32-BOOT-
Selection.jpg)

For the sake of convenience, let us call these BOOT selections as Programming Mode
and Operational Mode. For Programming Mode, the BOOTO pin is made HIGH and for
Operational Mode, the BOOTO pin is made LOW (default). In both the modes, the
BOOT1 pin stays LOW.

Hardware Requirements for the Project

Since this is our introduction part and all we will be doing is Blink an LED (which is
already present on the board), we don't need much hardware with respect to the

project and the MCU.

But for programming the Microcontroller, we need a USB to Serial Converter Module,
like an FTDI board (or anything similar). As mentioned in the BOOT Pins section, the

bootloader can be accessed using USART1 pins of the Microcontroller to program the
Flash Memory. And for the MCU to communicate with the USART1, we need a USB to

Serial Converter.

So, the final list of components required are:
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STM32F103C8T6 based STM32 Blue Pill Development Board

USB to Serial Converter Module (FTDI Programmer, for example)

Connecting wires

PC or Laptop with Windows OS and Internet connectivity

https://www.electronicshub.org/getting-started-with-stm32f103c8t6-b...

NOTE: | don't have an FTDI style programmer but have an older style USB to Serial

Converter. You can use any USB to Serial Converter modules as long it has VCC (5V),

GND

Con

For the purpose of easy representation, | am using an FTDI like USB to Serial

Converter in Fritzing Software to show the connections.

, RX'and TX pins.

nections

The connections should be as follows:

STM32 Blue Pill - FTDI Programmer
5V - VCC
GND - GND
A9 - RX
A10 - X
e o e e 9 ® L [ Z :
s e e e e e « e e e
R R R R R
| GiD GNP 3v3 NRST 811 810 BL B0 A7 M S A% A3 U2 U3 AD_(I5 (34 (13 VBAT
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Configuring Arduino IDE to Program STM32F103C8T6
Blue Pill

https://www.electronicshub.org/getting-started-with-stm32f103c8t6-b...

| am sure you already have Arduino IDE installed on your PC (or Laptop). If not, then

install it first. After than open your Arduino IDE and select File -> Preferences. You will

find a tab called “Additional Boards Manager URLs". Copy the following link and paste

it there.

" https://github.com/stm32duino/BoardManagerFiles/raw/master/STM32

/package_stm_index.json

f Preferences ﬁ1
Settings | Network|

Sketchbook location:

C:YUsers\TrailBlazer \Documents Arduino|
Editor language: SvstemDefai.llt v {requires restart of Arduino)
Editor font size: 12 |
Interface scale: Automatic | 1007 % (requires restart of Arduino)
Theme: :Default theme (requires restart of Arduing)
Show verbose output during: [V] compilation upload
Compiler warnings: Nune -

Dizplay kne numbers [] Enable Code Falding

Verify code after upload [[] Use external editar

2023. 01. 02. 19:59



Getting Started with STM32F103C8T6 Blue Pill | Program with Ardu... https://www.electronicshub.org/getting-started-with-stm32f103c8t6-b...

Chedk for updates on startup [#] Save when verifying or uploading
[7] Use accessibiity features
Additional Boards Manager URLs: | | https: /fgithub. comfstm32duino /BoardManagerFiles fraw master /[STM32/package_stm_index. json
More preferences can be edited directly i the Hie
C:\Users\TrailBlazer\AppData Local\Arduino 15\preferences. txt
(edit only when Arduino is not running]
[ ox | [ cancel ]

(https://www.electronicshub.org/wp-content/uploads/2020/02/STM32-Blue-Pill-Add-
URL-in-IDE.jpg)

If you already have some URLs in this section, you can add more by separating them
with comma. If you have worked with ESP8266 (https://www.electronicshub.org
/esp8266-projects/) Boards, then you might be familiar with this process already.
After adding the URL, click on OK.

Now, go to Tools -> Board -> Board Manager... option and search for “stm32". You will
get a result like “STM32 Cores by STMicroelectronics”. Install the latest version. At the

time of preparing this tutorial, the latest version is 1.8.0.

This will take some time as it will download and install some of the necessary files and
tools. (I said some because, you have to download another tool from

STMicroelectronics for this to work).

r B
¢ Boards Manager &

Type Al - |[stm32

g!ESZ Cores by STMicroelactronics I v
oards included in this package:

Nucles F2072G, Nudeo F42521, Nucleo F78721, Nucleo H74321, Nuclea H743212, Nucleo L4962G, Nudeo L4962G-P, Nucleo L4RSZE,
Mucleo L4R5ZI-P, Nucleo FO30RS, Nuclea FOS1RC, Nucleo F103RB, Nucleo F302RSE, Nucleo F303RE, Nucleo F401RE, Nuclea F411RE,
Mucles F446RE, Nuclan GOT1RE, Nucles G431REB, Nucles G4T4RE, Nucles LOSZRE, Nuclea LOTIRZ, Muclea L152RE, Nuclas L45SZRE,
Nuclea L452RE-P, Nucleo L47ERG, P-Nuclec WBS5RG, Nucles LOZ1KS, Nucleo L412KE, Nucles L432KC, Nucleo F202KE, Nucleo
G431KB, STM3ZFO20RE-DISCVL, STM3ZFO72B-DISCOVERY, STM22ZF100RB-DISCVL, STM32ZF407G-DISCL,
STM3Z2F746G-DISCOVERY, STM3ZL47SVG-DISCOVERY-10T, Discovary LO72CEZ-LRWAN1, SensorTile.box. STM32ZMP157A-DK1,
STM3ZMP157C-DK2, STM22F020F4 Demo board, STM32F020F4 Demo board (16Mhz), STM32F020F4 Demo board (internal RC
oscillater], BlueRill F102C6 (32K), BluePill F102C8, BlueFill F102C8 (128k), BlackFill F103CB, Blackpill F102C8 (12Bk), Generic
F103RSTE (Blue Button), Generic FLOZRETS (Blue Button), Generic FLO3RCTSE (Blue Button), Generic FI0ZRETS (Blue Button),
HY-TinySTM103TE, Maple Mini F103CE, RobotDyn BladkpRill F303CC, Black F407VE, Black F407VG, Black F407ZE, Black F407ZG,
Blua F407VE mini, DIYMORE STM32F407VGET, FK407TM1 STMI2F407VET, BlackPill F401CC, Core board FA0LRCTE, Adafruit Feather
STMZ22F405, Generic F401RE, Generic F401RD, Generic FA401RC, Genaric FA01RE, ThunderPack, PX-HERO, Wraith V1 ESC, RAKBLL
LoRa Tracker (16kb RAM), RAKEL11l LoRa Tracker (32kb RAM), RHF7E 052, Elektor LoRa Node Core FOT7Z, Armed V1, RemRam v1,
RUMBAZ2, STEVAL-3DPO01VL, PRNTR F407 v1, PRNTR v2, EExtruder FO30 V1, Malyan M200 V1, Malyan M200 V2, Malyan M300,
VAKE v1.0, Afro Flight Rev5 [8MHz), Afre Flight RevS [(12MHz), Sparky V1 F303 FC, MKR Sharky.
Qrﬂ'n: Halp

Mgre Info

1.8.0 o || Instal
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Close |

(https://www.electronicshub.org/wp-content/uploads/2020/02/STM32-Blue-Pill-Install-
STM32-Boards.jpg)

Now you can select the board from Tools -> Board -> Generic STM32F1 series. Once
you select this board, a bunch of options will appear below for customizing your
board type. The first important option is “Board part number”. Make sure that
“BluePill F103C8" is selected.

&% sketch_feb03a | Arduino 1.8.1; =REE X
File Edit Sketc Help @ |

-

Auto Format Ctrl+T
Archive Sketch
laE Ll Fix Encoding & Reload
1 void setup Manage Libraries... Ctrl+5Shift+I
;: ety Serial Monitor Ctrl+Shift+ M Boards Manager...
AR Serial Plotter Ctrl+ ShiftsL .
- oid loop(  WIFIOL/WIFiNINA Firmware Updater e Babot Mok
/ put ¥ _ _ 1 Arduino Gemma
: Board: "Generic 5TM32F1 series” j ! Adafruit Circuit Playgromnd
g} Board part number: "BluePill F103C8" ! Arduine Yan Mini
U(S)ART support: "Enabled (generic 'Serial')" ! Arduing Industral 101
USB support (if available): "Mone" ! L inins One

USE speed (if available): "Low/Full Speed” L
Optimize: "Smallest (-Os default)” I

Arduino Uno Wik

STM32 Boards (selected from submenu)

C Runtirme Library: "MNewlib Mano (default) Nucleo-144
. - n \

Upload method: "STM32CubeProgrammer (Serial) Nucleo-64

[
o Mucleo-32
Get Board Info -
Discovery
Programmer: "AVRISP mkI" X Eval

Burn Bootloader STM32MPL series coprocessor

Generic STM32F0 series
¥ Generic STM32F1 series @
Generic STM32F3 series
Generic STM32F4 series

=d(generic 'Serial'), None, LowFull Speed, Smallest {-Os default), Mewlib Nano (default) on COM
" Generic STM32L0 series

Electronic speed controllers
LoRa boards
3D printer boards

Generic fliaht controllers

(https://www.electronicshub.org/wp-content/uploads/2020/02/STM32-Blue-Pill-
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Selecting-Board-in-IDE.jpg)

The other important options are “U(S)ART support”, make it as “Enabled (generic
‘Serial’)” and “Upload method”, make its as “STM32CubeProgrammer (Serial)”. You can

leave the remaining options as their default values.

r@_ sketch_feb03a | Arduino 1.8.11 | B
File Edit Sketch Tools| Help |
Auto Format Ctrl+T
Archive Sketch
Ll L Fix Encoding & Reload
1 woid setup Manage Libraries... Ctrl+5Shift+I
¢ MEEE Y seral Monitor Ctrl+ Shift+M
' Serial Plotter Ctrl+Shift+L
& void loop | wrepdute
i % Board: "Generic 5TM32F1 series” k
g1 /s Board part number: "BluePill F103C8" k
%’ U{S)ART support: "Enabled (generic 'Serial’)" L4
USE support (if available): "None" k
USE speed (if available): "Low/Full Speed” L
Optimize: "Srnallest (-O0s default)” L4
C Runtime Library: "Mewlib MNano (default)” L4
I%’ Upload method: "5TM32CubeProgrammer (Serial)” k
Port b
Get Board Info

Prograrmmer: "AVRISP mikdl" k

Burn Bootloader

Generic STM32F1 series on COMS

(https://www.electronicshub.org/wp-content/uploads/2020/02/STM32-Blue-Pill-
Config-Blue-Pill-in-IDE.jpg)

Downloading STM32CubeProgrammer

In the above step, we have selected “STM32CubeProgrammer (Serial)” as the upload

14/24 2023. 01. 02. 19:59
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method but the problem is this tool is not downloaded and installed by the Boards
Manager. So, we have to manually install it. For that, go to the official
STM32CubeProgrammer download page provided by STMicroelectronics using the

following link.

STM32CubeProgrammer (https://www.st.com/en/development-

tools/stm32cubeprog.html)

Click on Get Software option and it will take you Login/Register page. | suggest you to
register with STMicroelectronics with a valid e-mail ID. Once you register, you can

login and download the software.

] B stcom/en/development-tools/stm32cubeprog. htmi#get-software I I

Get Software

Part Number & General Description Software Version Downioad Previous versions

STM32CubeProg  STM32CubeProgrammer software for all STM32  2.3.0

(https://www.electronicshub.org/wp-content/uploads/2020/02
/STM32CubeProgrammer-Download.jpg)

A large zip file (approximately 164 MB for version 2.3.0) will be downloaded. Extract

the zip file and you will get a Windows exe file with name

“SetupSTM32CubeProgrammer-2.3.0". Double click and proceed with installation.
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Setup5TM3 | enstm32cu | SetupSTM3 | SetupSTM3

2CubeProg | beprog_v2- | 2CubeProg | 2CubeProg

rammer-2.3 | 3-0 rammer-2.3 | rammer-2.3
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(https://www.electronicshub.org/wp-content/uploads/2020/02
/STM32CubeProgrammer-Zip-File.jpg)

Make sure that the installation directory is default and don't change anything. It might
ask your permission to install some drivers for ST-Link. You can grant necessary

permissions.

Once the installation is complete, make sure that in the path “C:\Program
Files\STMicroelectronics\STM32Cube\STM32CubeProgrammer\bin” you have the

“"STM32_Programmer_CLI" exe file. If it is present, then you are good to go.

e = —
Iv Al =3 croeheciron 32C b 32C ubePragranm e bin I = | 4 ||| Searchi p=
- = £ — —_ -
ue = Inchude in library = Shane with Bum New falder HE il @
wernites
| ) ) ) e o ) e ) el ) a
Desktop J: I i .y -y -y -y -y -y -y -y Roch -y gy
Dewnlosds Externailes  FlashLoade HEM RS%e CubeProgr  FileManage HIM P11 L libeay32dll  libgee s s Bbotdes -6 libwinpthre  micl20dil movepldd.  moverdO0d  moverldd
Recant Places der t armmer_AF1 il .l b1l il ad-1.di dil 1 I
il
brasies s o & & e B! € s 5
Documents b -~ e -y - - - -
Music Qt5Coredll  QtSSerialPe  QtSxXmidll stlibpll 53A  stlibpll SA  STLinkUSE J STM3Z Pro STW3ICub  STMEZMP_  STMEZMP_  werces-c dibl dil
4 ri.dll M.conf MLl Deiverdll  § grammer C | eProgram  KeyGen CU  SigningToo 1.1
Pictures u P Lou
Videos

(https://www.electronicshub.org/wp-content/uploads/2020/02
/STM32CubeProgrammer-Path-Verify.jpg)

NOTE: It can be either Program Files or Program Files (x86) in the above path.

This completes the software setup for Arduino IDE to program STM32 Blue Pill. Let us

proceed with writing a small program for blinking an LED and uploading it to our
STM32F103C8T6 Blue Pill Board.
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Blinky Program for STM32F103C8T6 Blue Pill Board

Make sure that you made the necessary changes to the Arduino IDE as mentioned in
the previous section (selecting the correct board, etc.). Once that is done, make the
connection between FTDI Programmer (i.e. USB to Serial Converter) and STM32 Board

as mentioned before.

Now, before connecting the FTDI to the PC, make sure that STM32 Blue Pill Board is in
“Programming Mode” i.e. connect the BOOTO pin to HIGH. After that, connect the
FTDI to the PC or Laptop. A COM port will be assigned to the programmer and select
the same COM port in the Arduino IDE.

Write the Blinky program as follows. It is similar to the Arduino Blinky sketch but
instead if LED_BUILTIN, | have used PC13 as the LED is connected to that pin of the
MCU.

Code

void setup() {

pinMode(PC13, OUTPUT),

void loop() {
digitalWrite(PC13, HIGH);
delay(1000);

digitalWrite(PC13, LOW);
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delay(1000);

Blink | Arduino 1.8.11 ==

File Edit Sketch Tools Help

void setup() { A
pinMode {PC13, OUIPUT);
}

s L ka2

void loop() {
digitalWrite (PC13, HIGH):
delay {1000} 2
digitalWrite (PC13, LOW):
delay {1000} ;

=1 @ N

[ T N T+ |

(https://www.electronicshub.org/wp-content/uploads/2020/02/STM32-Blinky-
Code.jpg)

After this, you can click on Upload and the IDE will start compiling the code. It will take

some time for compiling.

i N
& Blink | Arduino 1.8.11 ENENT

File Edit Sketch Tools Help

1 |woid setup() { =
pinMode (PC13, OUTEUT):

3l
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5 delay(1000);
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(https://www.electronicshub.org/wp-content/uploads/2020/02/STM32-Blinky-
Compilation.jpg)

Once the compilation is successful, it will automatically invoke the
STM32CubeProgrammer tool. If everything goes well, the IDE will successfully

program the STM32 Board.

&5 Blink | Arduino 18,11 e N

File Edit Sketch Tools Help
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Generic STM32F1 series on COMS

(https://www.electronicshub.org/wp-content/uploads/2020/02/STM32-Blinky-
Upload.jpg)

It will automatically reset the MCU and you can notice the LED blinking. Don't forget
to move the BOOTO pins back to LOW position so that the next time you power-on

the board, it will start running the previously uploaded program.

Conclusion

This was a lengthy tutorial on Getting Started with STM32 Blue Pill Board i.e.
STM32F103C8T6. | have discussed some of the important features of the Board,
highlights of the MCU, known issues of the board and how to fix them, configuring
Arduino IDE, downloading necessary tools, writing our first program for STM32 on

Arduino Ide and finally uploading the program and see the LED blink.

If you have any queries, questions or doubts, please comment below so that | or any

other user can respond.
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